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MasterTax is excited to announce that clients will soon be able to license the ADP Tax                   
Locator, which enables payroll, tax, and human resource professionals to easily identify local 
tax information for new and transferred employees. 
 
The ADP Tax Locator is incredibly easy to use: the employer simply enters the employee’s 
home and work addresses, and within seconds, the locator identifies all relevant local tax 
codes and rates, MasterTax tax codes, jurisdiction names, and collector names.  The locator 
also enables employers to maintain a history of past addresses for each employee. 
 
The locator virtually eliminates penalties due to incorrect tax setups, and employers can     
realize an immediate and significant time savings by no longer having to research all                          
municipal, school district, county, and state codes and tax rates.  This is especially of benefit 
to companies with employees spanning multiple states and municipalities.   
 
The ADP Tax Locator is expected to be released to MasterTax clients in the fourth quarter of 
2011.  For additional information, send an e-mail to emailus@mastertax.net.  
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PPA Feature Enhanced for Mass Rate 
Changes 

As of the third quarter 2011 Release, MasterTax clients will be able to quickly add prior                      
period adjustments (PPAs) for mass changes that affect a specific SUI tax code.  This                                    
enhancement is particularly useful when processing a large number of SUI rate changes for 
a prior period or for new minor tax codes. 
 
MasterTax will calculate the balance due or credit, based on the new rate and wages                    
previously reported for the specified period for all impacted companies, saving a significant 
amount of time by eliminating the need to calculate and enter each amount manually.  After 
reviewing the calculated adjustments, you can change the amounts prior to submitting.   
 
Users also have the option of paying the balance due immediately, or applying it to the next 
return.  Credits are to be applied to the next return. 
 
The newly added PPA transactions will be available in the PPA Post window.  
  
Additional information about this enhancement will be available in the Release Notes on                  
September 13, 2011.   
 
For questions, please contact a Support Representative at 480-778-8734, or send an e-mail 
to support@mastertax.net. 
 



Q:  How do I know when updates or hotfixes are available to my MasterTax software? 
 

A: Client/Server and Self-Hosted Customers: 
Hotfixes are available via Help>Check Updates throughout the quarter.  MasterTax                           
recommends checking for hotfixes each morning prior to beginning processing.  It is                  
especially important to check for hotfixes during quarter-end processing months.   
 
Notifications are e-mailed to those who are specified as Users on their company’s Contact 
List when a hotfix is deemed critical, or when a release or update is available.   
 

Hosted Customers: 
Releases, updates, and hotfixes are automatically applied to Hosted accounts.  While there is 
no need for the user to install these, some action maybe be required as part of the update or 
fix. Notifications are e-mailed to those who are specified as Users on their company’s                      
Contact List when a release or update has been applied.   
 
You can view or print the notes for a hotfix in the View Update Log window [Help>About               
MasterTax>View Update Log].   

 
Q: When should I use Transaction Utilities? 
 

A: Transaction Utilities are very powerful, and generally should not be used unless you have 
been advised to do so by a MasterTax Support Representative.  It is difficult and                         
sometimes impossible for Support to correct a process that has been created or modified in 
Transaction Utilities.  If you are experiencing an issue you feel requires use of                       
Transaction Utilities, you should first contact a Support Representative to assist you.   

 

Important 
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New ADP W-2 Print Services Interface 

As of the third quarter 2011 Release, MasterTax clients who are licensed for the W-2 Reporting 
module have an additional option available for producing employee W-2s:  ADP Print Services.   
 
Using ADP Print Services for W-2 printing is the most complete solution for managing year-end 
tax requirements.  Employers will appreciate the reduction in paper and postage costs, security 
fees, and time spent reissuing W-2s.  Employees will enjoy the convenience of accessing their  
W-2s online at any time.  Personal information, such as Social Security Numbers, are password                    
protected, and can be suppressed during printing. 
  
A new menu item, ADP PSS, will be added to the Features>Employee W-2 Services menu for                 
W-2 Reporting clients.  This new menu item will enable you to generate an ADP PSS Export 
file that can be submitted on ADP's secure website.   
 
Registration is required prior to using this service.   For information, please send an e-mail to                        
marketing@mastertax.net. 

MasterTax Help Desk 

Sept. 13, 2011 

Third Quarter                    
Release 

 

Sept. 12-14, 2011 

MasterTax                        
Exhibiting at 
NAPEO                               
Professional                   
Employer &                         
Marketplace 

 

Oct. 2-6, 2011 

MasterTax                          
Exhibiting at Oracle 
OpenWorld 

 

Oct. 6, 2011 

Third Quarter                   
Update 

 

Oct. 6, 2011 

Quarter-End               
Processing                    
Webinars 

 

Oct. 7, 2011 

Enhancements  
Webinars 

 

Oct. 24-26, 2011 

MasterTax                         
Exhibiting at                   
Workday Rising 

 

Nov. 24, 2011 

Office Closed: 

Thanksgiving Day 

 

Nov. 25, 2011 

MasterTax is open                       
regular business 
hours! 

MasterTax “White Labeling” Forms 

MasterTax is in the process of removing the “MasterTax” label from all tax agency forms, except 
for those of agencies that require identification of the form’s builder.  This includes forms that are 
contained in company packages.  White labeled forms are expected to be fully released to clients 
in the fourth quarter of 2011. 



Top 10 Reasons to Attend Synergy ‘12 
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Take a time out!Take a time out!Take a time out!Take a time out!   
Have fun and be entertained with nightly 
activities  
 

Enjoy the Home field advantage!Enjoy the Home field advantage!Enjoy the Home field advantage!Enjoy the Home field advantage!  
Live it up in the warm, sunny weather in 
beautiful Scottsdale, Arizona 
 

Learn from the All Stars!Learn from the All Stars!Learn from the All Stars!Learn from the All Stars!   
Listen to and connect with industry- 
leading speakers 
 

Improve your stats!Improve your stats!Improve your stats!Improve your stats! 
Earn RCH credits 
 

Train with the Pros!Train with the Pros!Train with the Pros!Train with the Pros!   
Speak one-on-one with the MasterTax  
Development team 
 

Step up to the plate!Step up to the plate!Step up to the plate!Step up to the plate!   
Share your thoughts and opinions in  
sessions specifically designed to  collect 
User feedback 
 

Meet your team members!Meet your team members!Meet your team members!Meet your team members!   
Meet and consult with the MasterTax team 
 

Play ball!Play ball!Play ball!Play ball!   
Network with other MasterTax Users 
 

Cover your bases!Cover your bases!Cover your bases!Cover your bases!   
Participate in Best Practices panel  
Discussions 
 

Join the Major Leagues!Join the Major Leagues!Join the Major Leagues!Join the Major Leagues!   
Enhance your knowledge of MasterTax  
software 
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Who: 
 

MasterTax               
Customers 

What: 
 

Synergy ‘12                         
MasterTax’s             

Biennial User 
Conference  

When: 
 

March 25-28, 
2012 

Where: 
 

Scottsdale, AZ 
 

Talking Stick 
Resort 

 

Details on 
Synergy ‘12: 
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Customizable Power of Attorney Forms 
In the Power of Attorney Configuration window, you can view the list of agency Power of  
Attorney (POA) forms that are supported by MasterTax.  The Filing Information column  
shows any special requirements for a form, such as whether or not it must be signed by  
a Notary.  
 
For many POA forms, you can define settings for custom fields.  By doing so, you can ensure 
that your POAs contain all the required information, and that they are configured consistently.  
Additionally, using custom fields eliminates the need to complete POAs by hand, which saves 
time for both the authorized agent and the company being represented.   

To customize a Power of Attorney form: 
1. In the MasterTax Home window, select Features>Enrollment from the menu bar. 
2. On the Enrollment Desktop, click the Power of Attorney link under the “Configuration” heading. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3. If the Custom Fields column is set to Yes, the form is customizable.  Click the ellipses button (      )  

at the end of the form’s line to view and populate its custom fields.  
4. After working through the custom fields, click Submit. 
 
 

 

Notes: 

1. We recommend 
you print a blank 
copy of the POA 
form to use as a 
reference before 
customizing 
fields.   

 

2. You can click the 
Run Report              
button to print a 
listing of the POA 
configuration 
settings to keep 
on hand for           
future reference. 
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Tax, Form, and Software Updates 
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New Tax Setup  
The following tax codes will be added to MasterTax as of the third quarter 2011 Release. Please 
refer to the Release Notes for further clarification and other changes not mentioned here. 

 

• AZ0000-148 – Arizona - Employer Special Assessment Surcharge 

• CT0000-148 – Connecticut - Special Assessment 
• IL0000-148 – Illinois - Small Business Jobs Creation Tax Credit 
 

Electronic File Updates 
The following changes will be made to electronic files in MasterTax as of the third quarter 2011 
Release.  Please refer to the Release Notes for further clarification and other changes not                 
mentioned here. 

 

• Georgia Withholding (GA0000-001) – The layout of the e-file for the Georgia Quarterly 
Return for Semi-Weekly Payer (form GA G-7) has been updated to match the agency’s 
latest specifications. 

 

• Illinois Unemployment (IL0000-010) – Support of the Mag Media - CD method has been 
added for the Illinois Employer's Contribution and Wage Report (form IL UI-3/40). 

 

• Utah Withholding (UT0000-001) – A template is now provided to convert the MasterTax 
e-file for the Utah Withholding Return (form UT TC-941) to Microsoft Excel format, as  
required by the agency.  Refer to the e-Filing Instructions for more information [Help> 
e-Filing Instructions>Tax Return e-Filing Instructions].     

 

• Vermont Unemployment (VT0000-010) – If you e-file the Vermont Employer's Quarterly 
Wage & Contribution Report (form VT C-101), a Remittance file will now be generated by 
the Tax Return process.  This file must be sent to the agency.  Refer to the e-Filing  
Instructions for more information [Help>e-Filing Instructions>Tax Return e-Filing  
Instructions].   

 

• Virginia Withholding (VA0000-001) – The Virginia Department of Taxation requires 
semi-weekly payers to file their quarterly returns electronically.  Support of the e-File 
method has been added for the Employer's Quarterly Reconciliation and Return of                 
Virginia Income Tax Withheld (form VA VA-16).  Refer to the e-Filing Instructions for  
more information [Help>e-Filing Instructions>Tax Return e-Filing Instructions].  

 

• Grand Rapids, Kent Withholding (MI0006-001) – Support of the EFT Credit method  
has been added.  Refer to the EFT Instructions for more information [Help>EFT  
Instructions>EFT Instructions for Payroll Taxes]. 

 

• Keystone Collections Group – Support of the Mag Media - CD method has been added 
for Pennsylvania local EIT and LST taxes reporting to Keystone Collections Group.  In 
addition, the layout of the e-files for EIT and LST returns has been updated to match the 
agency's latest specifications. 

 

• Lancaster County Tax Collection Bureau – Support of the Mag Media - CD method 
has been added for Pennsylvania local EIT and LST taxes reporting to Lancaster County 
Tax Collection Bureau.    

 

• York Adams Tax Bureau – Support of the EFT Credit method has been added for  
Pennsylvania local taxes reporting to York Adams Tax Bureau.  Refer to the EFT  
Instructions for more information [Help>EFT Instructions>EFT Instructions for Payroll 
Taxes]. 
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“Thank you 
so much for 
ALL of your 
help! Your 
Support 
team is 

awesome! 
AWESOME!” 

 
Tina Wiley 

Tax Specialist,              
Strategic                          

Outsourcing, Inc. 



Tax, Form, and Software Updates (Continued) 
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Tax Rule Changes 
The following tax rule changes will be made to MasterTax as of the third quarter 2011 Release.  Please refer to the  
Release Notes for further clarification and other changes not mentioned here. 
 

• Georgia Withholding (GA0000-001) – The Georgia Department of Revenue does not require submission of zero 
deposits; therefore, the Zero Deposit rule has been removed for this tax. 

 

• New Hampshire Administrative Contribution (NH0-000-128) – This tax has been changed from an EIN-rated 
tax to an agency-rated tax at a rate of .2%.  

 

• New Jersey Employee Unemployment (NJ0000-020) – This tax has been changed from an agency-rated tax to 
an EIN-rated tax. 

 

Enhancements 
The following enhancements will be added to MasterTax as of the third quarter 2011 Release.  Please refer to the Release 
Notes for further clarification and other changes not mentioned here. 
 

• The ability to mark the South Dakota quarterly contribution and wage report (form SD DOL-UID-21) as the final  
return for a company has been added [Master>Company View>Tax>Return>Mark as Final]. 

 

• The ability to add a FUTA credit reduction tax code to multiple companies at one time has been added to the  
Quick Edit tab [Master>Company View].  To use this feature, set the Edit option to Company Tax, set the Edit  
field to Add FUTA Credit Reduction Codes, and select the FUTA credit reduction tax in the Tax Code field.  

 

• Support of TimePlus vendor tax codes has been added to the Tax Code Alternate window [List>Import Setup> 
Tax Code Alternate>Load Vendor Tax Codes]. 

 

• The following check boxes have been added to the Federal Processing category in the Process Options window 
[Process>Options>Federal Processing]: 

 

• Produce 941 Liability Schedule When Total Liability for Quarter Is Less Than $2,500 - Enables you to            
produce federal form 941 schedule B for companies for which the quarterly liability is less than $2,500. 

 

• Use Name Control to Replace FEIN Check Digit in Federal 94X e-Files - Replaces the <CheckDigit>               
element in federal 94x e-files with the <BusinessNameControl> element. 

 

• The Allow Cash Refund Only After the Corresponding Payment Is Not Negative check box has been added 
to the Cash Processing category in the Process Options window [Process>Options>Cash Processing].  This check 
box enables you to prevent cash from being refunded when the corresponding deposit is negative.  

 

• The ability to release all held variances has been added to the Variance Post window [Process>Quarter-End  
Processing>Variance Post]. 

 

• The Switch to Paper button has been added to the Tax Return Select window when accessed via the e-File  
or Mag Media tab in the Create Tax Returns window [Process>Quarter-End Processing>Tax Return] or the  
Re-create Tax Returns window [Utilities>Reprint Tax Return].  Clicking this button changes the filing method to  
Paper for the selected companies' returns. 
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MasterTax reminds you to please inform a Support Representative when your company has an additional MasterTax 
user. 
 
The easiest way to add a new user to your account is to send an e-mail to support@mastertax.net.  Please include 
the new user’s full name, e-mail address, and telephone number.  You should also indicate whether or not the new 
user would like to receive notifications from MasterTax.   
  
Please note:  Only an existing contact can add a new user to your account.  New users cannot add themselves.   
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Service providers that use the 
Cash Care module have the 
ability to differentiate between 
various cash types, including                  
variances, PTS liabilities,            
deposit adjustments, and cash 
adds.   
 
In the Cash Collection window, 
simply select the Cash Type 
you want to be displayed. 

You can also report on specific 
cash types in the Cash  
Analysis report (Reports> 
Cash>Cash Analysis). 
 
If you are not currently using 
the Cash Care module and 
would like more information 
about this offering, please  
contact a  MasterTax Support                 
Representative by phone at 
480-778-8734, or by e-mail at 
support@mastertax.net. 

Differentiating 
Between Cash 
Types… Yes, We 
Do That! 

Tax, Form, and Software Updates 
(Continued) 

• The ability to generate Avery 5692 CD labels has been added to the following 
processes: 

 

• Tax Return 

• Reprint Tax Return 

• Amended Tax Return 

• Reprint Amended Tax Return 
 

• The following changes have been made to the Company Package Print window 
[Process>Quarter-End Processing>Company Package] and the Company 
Package Reprint window [Utilities>Reprint Company Package]: 

 

• The W-2 Count column has been added, showing a company's federal 
W-2 counts for fourth quarter packages. 

 

• A note has been added, showing the number of packages that are            
currently selected to be produced. 

 

• An exclamation point (!) has been added next to a company's                     
package if an amendment exists for the  company and quarter.  

 

      In addition, federal form FE 1096 has been added to the company packages. 
 

• Display of the worksite number has been added to the RTS Employee Wage 
Detail report [Reports>QE Reconciliation>RTS Detail]. 

 

• The ability to restrict the Reissue Cash by Process ID task to a specific cash 
collection method has been added to the Transaction Utilities window 
[Utilities>Transaction Utilities]. 

 

• The Group by - Process Date and Group by - Deposit / Collection Date options 
have been added to the Bank Reconciliation - Bank Account Report window 
[Features>Bank Reconciliation>Reports>Bank Account].  These options apply 
only to the EFT Payments, Checks, and Cash Collections report versions. 

 

• A custom field has been added for the Colorado Unemployment EFT                              
authorization agreement (form CO SIT EFT APP), enabling you to populate the 
taxpayer address with the address from the Profile pane in the Preferences  
window. 

 

• Support of the secure E-mail rate exchange method has been added, and                
support of the Tape method has been removed, for Arizona Unemployment 
(AZ0000-010).  Refer to the SUI Rate Exchange Instructions for more                      
information [Features>SUI Rate Exchange>Configuration>SUI Rate                            
Exchange>     ]. 

 

• The following buttons have been added to the PPA Post window [Features> 
Amendment>Transaction>Period Period Adjustment or Transaction>Prior     
Period Adjustment]: 

 

• Void - Enables you to void multiple PPAs. 
 

• Quick PPA Add - Opens the Quick PPA Add for SUI Rate Change  
window where you can generate prior period adjustments for an                   
unemployment tax rate change for multiple payroll codes at one time.  

 

• Support of View Only access has been added for the Wage Attachment Deposit 
Maintenance window. 
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Compliance Corner 

Review the items below for relevant and topical information for the Payroll  Professional.  The 
information comes from various agency websites and publications.  Please contact the agency 
involved if you require more information.  

 

• Alabama - Effective April 1, 2012, employers must not knowingly employ, hire for                   
employment, or continue to employ an unauthorized alien to perform work in Alabama.  
Employers are required to register and use E-Verify for all newly hired employees.                   
Employers with 25 or fewer employees will be permitted to use an E-Verify employer 
agent service established by the Alabama Department of Homeland Security.  Failure to 
comply with these requirements may result in suspension and/or loss of a business                 
license for the employer.  For more information, click here. 

 

• Delaware - Effective January 1, 2012, same-sex couples will be permitted to register 
with the state as civil unions.  The same state rights and benefits will be extended to civil 
union partners as are currently provided to married couples.  Employers that provide 
health insurance coverage for employees’ spouses and their children must provide it for 
employees’ civil union partners and their children on the same terms.  The benefit is  
similarly exempt from state income taxation.  Also effective January 1, 2012, the state 
will recognize same-sex civil unions legally performed elsewhere.  For more information, 
click here. 

 

• Massachusetts - Effective April 7, 2011, the weekly amount exempt from withholding for 
a creditor garnishment is the greater of: 1) 85% of the employee’s gross wages; or 2) 50 
times the federal minimum wage ($7.25 an hour) or the Massachusetts minimum wage 
($8.00 an hour).  Previously, $125 of an employee’s weekly wages were exempt from 
withholding.  For more information, click here, and scroll to page 16. 

 

• Michigan - Effective January 1, 2012, professional employer organizations (PEOs) must 
obtain a license from the Department of Energy, Labor, and  Economic Growth no later 
than July 1, 2012.  Effective September 1, 2012, the DELEG may begin issuing limited 
licenses to PEOs domiciled outside of the state if they meet certain criteria.  For more 
information, click here. 

 

• New York - Effective July 24, 2011, same-sex marriage is legal in New York.  Under the 
Marriage Equality Act, opposite-sex and same-sex marriages are treated equally under 
the laws of New York.  Employers that provide health insurance coverage for employees’ 
opposite-sex spouses and their children must also provide it for employees’ same-sex 
spouses and their children on the same terms.  For more information, click here. 

 

• North Carolina - The Employment Security Commission of North Carolina has issued a 
new form NCUI-500AB, Request for Separation Information from Employer.  This new 
form is two pages (it was formerly one page), and requires more detailed information 
regarding pay, nature of employment, and reason for separation.  Employers must return 
form NCUI 500AB within 10 days from the date the form was mailed or generated by the 
Commission. Failure to return the form within 10 days may result in increased benefit  
charges and higher  unemployment insurance taxes.  The new form has a revision date 
of 06/2011.  For more information, click here. 

 

• North Dakota - Effective January 1, 2012, all employers must include on all new hire   
reports whether or not they offer health insurance to the employee.  Also effective  
January 1, 2012, an employer with more than 24 employees must submit new hire              
reports electronically to the Child Support Enforcement Division. Employers may request 
a waiver for good cause if the employer believes that complying with the electronic              
reporting requirement will cause special difficulties.  For more information, click here. 

 

Want More  
Payroll Tax 
News? 

 

Follow us on              

by clicking here. 

 

Join the Payroll 
Tax Compliance 
Professionals 

group on 

by clicking here. 

http://www.dhs.alabama.gov/headlines/2011/apr_june/HB56.pdf
http://legis.delaware.gov/LIS/LIS146.NSF/vwlegislation/916160214DBB1927852578540067CE78
http://www.adp.com/tools-and-resources/newsletters/tech-flex/~/media/1C9212FA05514C4D9D778567C2A620B9.ashx
http://www.legislature.mi.gov/documents/2011-2012/billenrolled/House/htm/2011-HNB-4584.htm
http://www.tax.ny.gov/pit/withholding_mea.htm
http://www.ncesc1.com/business/ui/UiClaims3.asp
http://www.nd.gov/dhs/services/childsupport/docs/new-hire-reporting-law-change-jan-2012.pdf
www.twitter.com/mastertax
http://www.linkedin.com/groups?gid=2255434&trk=myg_ugrp_ovr
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Compliance Corner (Continued) 

• Pennsylvania - Changes to the earned income tax (EIT) collection system are scheduled to go into effect in 2012; 

however, counties are permitted to implement the changes a year early.  The changes to the EIT collection                  
system are schedule to be implemented early in four counties: Chester, Lancaster, Lebanon, and Wyoming.                    
However, Chester County is the only one enforcing early adoption.  Effective August 1, 2011, employers are                
subject to penalties and interest for failing to comply with the requirements of the EIT collection system in Chester 
County.  If the EIT is not paid when due, interest is due on the amount required to be paid, and an additional              
penalty of 1% of the amount of the unpaid EIT applies for each month or fraction of a month that it remains                 
unpaid, up to an aggregate maximum of 15%.  Compliance is voluntary for employers in the other three counties, 
which will not enforce it or penalize employers in 2011.  For more information, click here, and scroll to page two. 

 

• Tennessee - Effective July 1, 2011, an employer is permitted to use a wage deduction to recover money owed by 
an employee if: 1) the employer entered into an agreement with the employee to advance the employee wages 
before the date the wages are owed, including permitting the employee to charge personal items on a corporate 
credit card; 2) the employee signs the written agreement and the employer retains it; and 3) the employer notifies 
the employee in writing 14 days before the payment of wages is owed.  An employer is not permitted to use a 
wage deduction if the employee sends a sworn affidavit, contesting the amount of money owed, to both the               
employer and the Department of Labor and Workforce Development within 7 days after receiving notification from 
the employer.  The employer may initiate a civil action to recover the contested amount owed from the employee.  
For more information, click here. 

 

• Washington - The Paid Family Leave Insurance (FLI) program, scheduled to be implemented on October 1, 

2012, has been delayed and will instead take effect on October 1, 2015.  For more information, click here. 

Company Updates 

We are pleased to announce Bill Corwin as the new Vice President, MasterTax, operating out 
of the Scottsdale, Arizona office. 
  
Bill possesses extensive payroll software, service delivery, client relations, and implementation 
experience, and holds a B.S. in Management from the University of Illinois at Chicago.  His 
skills and expertise add considerably to MasterTax’s ability to address the challenges faced by 
our clients and identify new and exciting product and service options to support our clients’ 
business success. 
  
“I couldn’t be more excited to join the MasterTax team,” said Bill.  “I look forward to leading the 
organization as we drive growth, invest in our next generation of insightful solutions, and                    
continue to deliver an exceptional client experience.” 
  
Please join us in welcoming Bill to MasterTax. 

We Want Your  Feedback!  

 

Tell us what you want to see in MasterNews! 
 

MasterTax gladly welcomes your comments and  
suggestions.   

 
Click here to send us an e-mail! 

 

Published by: MasterTax, LLC 
 

Phone:  480-778-8734   Fax:  480-778-8748 
7150 E. Camelback Rd., Ste. 160, Scottsdale, AZ 85251 

 

www.mastertax.net                                                                   
emailus@mastertax.net  

MasterNews 

http://legacy.americanpayroll.org/pdfs/pc2011/11mayidc.pdf
http://www.capitol.tn.gov/Bills/107/Bill/HB1819.pdf
http://apps.leg.wa.gov/documents/billdocs/2011-12/Pdf/Bill%20Reports/House/5091-S.E%20HBR%20APH%2011%20E1.pdf
mailto:newsletter@mastertax.net



